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* Note

Correct Answer will carry 1 mark per Question.
Incorrect Answer will carry 1/3 Negative mark per Question.

1. Options shown in green color with a tick icon are correct.
2. Chosen option on the right of the question indicates the option selected by the candidate.

Section : General Awareness

Q.1 Pandit Chhannulal Mishra, who passed away at the age of 89, was associated with
which of the following Hindustani classical music gharanas?

Ans 25 1.Agra Gharana
w* 2. Gwalior Gharana
#% 3. Banaras Gharana
X 4. Jaipur-Atrauli Gharana

Q.2 The Kol Uprising, which resisted British law and order intervention, took place in which
region?

Ans X 1. Mysore
«" 2. Awadh
#5 3. Chotanagpur
/5 4.Bengal

Q.3 In 2025, which Indian cricketer became the first Indian pacer to play 50 Test matches for
the country?

Ans X 1. Ishant Sharma
#X 2. Bhuvneshwar Kumar
" 3. Mohammed Shami
X 4. Jasprit Bumrah

Q.4 Which folk music tradition from West Bengal, associated with spiritual themes, is
performed by wandering minstrels?

Ans 5 1. Baul
#% 2. Pandavani
o 3.Alha
X 4.Bhavai

Q.5 The Constitution of India prohibits which of the following types of citizenship?

Ans #5 1. Citizenship by registration under statutory provisions
#% 2. Dual citizenship of another country along with Indian citizenship
«” 3. Citizenship by birth within the territory of India

#X 4. Citizenship by naturalisation after fulfilling prescribed conditions
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Q.6  When and where did the first session of the Indian National Congress take place?
Ans X 1. January 12, 1885, Calcutta

" 2. December 28, 1852, Poona
25 3. December 28, 1885, Bombay
X 4. December 28, 1885, Poona

Q.7  As per Article 280(1) of the Constitution, the Finance Commission is to be constituted:

Ans X 1. Every four years or earlier
" 2. Every three years
25 3. Every five years or earlier

X 4. Every seven years or earlier

Q.8  Shri C. P. Radhakrishnan was sworninas ______ Vice President of India.
Ans X 1.12th

o 2. 15th

< 3.14th

X 4.13th

Q.9 Which of the following pairs of peaks and their approximate heights is matched
INCORRECTLY?

Ans #5 1. Kanchenjunga - 8598 m
#% 2. Dodabetta - 2637 m
#5 3. Nanga Parbat - 7026 m
" 4. Anaimudi - 2695 m

Q.10 Which of the following was NOT a key component of the 1991 industrial reforms in
India?

Ans 5 1. Expansion of the public sector in key industries
X 2. Encouraging Foreign Direct Investment (FDI)
25 3. Abolition of the Monopolies and Restrictive Trade Practices (MRTP) Act

4" 4. Delicensing of industries

Section : General Intelligence and Reasoning

Q.11 What will come in the place of ‘?’ in the following equation, if ‘+’ and ‘-’ are interchanged
and ‘x’ and ‘+’ are interchanged?

297 x 11 -17 + 18 + 91 =2
Ans 51,242

X 2.245

X 3.248

& 4. 240
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Q.12 A question is followed by two statements numbered | and II. You have to decide
whether the data provided in the statements are sufficient to answer the question. Read
both the statements and select the most appropriate answer.

Six people, A, B, C, D, E and F, are sitting in a straight line, facing north. Who sits to the
immediate left of E?

I. B sits fourth to the right of C. Only one person sits between C and F. D sits third to
the right of F.

Il. C sits at the extreme left end of the line. Only two people sit between C and E. A sits
fourth to the left of D.

Ans 5 1. The data in both Statements | and Il put together (and not independently) are sufficient to answer the question.
" 2. The data in Statement | alone is sufficient to answer the question while data in Statement Il is not.
#5 3. The data in Statement Il alone is sufficient to answer the question while data in Statement | is not.

#5 4. The data in both Statements | and Il put together are NOT sufficient to answer the question.

Q.13 Seven people, C, D, E, F, W, X and Y, are sitting around a circular table facing the centre
of the table. Only two people sit between C and D when counted from the left of D. X
sits to the immediate right of D. Only three people sit between D and E. F sits to the
immediate right of W. How many people sit between Y and F when counted from the
right of F?

Ans X 1. Three
X 2. Zero
X 3.0ne
¥ 4. Two

Q.14 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.

(Left) 13€£746¥28%$631<0139025%7509 (Right)

How many such symbols are there that are immediately preceded by an odd number
but not immediately followed by an even number?

Ans «” 1. Four
< 2.0ne
X 3.Two
X 4. Three

Q.15 Based on the English alphabetical order, three of the following four letter-clusters are
alike in a certain way and thus form a group. Which letter-cluster DOES NOT belong to
that group?

(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 5 1. MHJ
o 2. RMO
X 3.7OQ
X 4. KEH

Q.16 In a certain code language,

A + B means ‘A is the son of B’,

A — B means ‘A is the brother of B’,
A x B means ‘A is the wife of B’, and
A + B means ‘A is the father of B’.

Based on the above, how is L relatedto Pif ‘L+ M+ N x O -P’?
Ans X 1. Brother’s wife’s father
X 2. Wife’s father
X 3. Wife’s brother

«" 4. Brother’s wife’s brother
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Q.17 | Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only. All numbers are single-digit numbers.
(Left) 91 @$51#59$18&4+7=158&4? (Right)

How many such symbols are there each of which is immediately preceded by a number
and also immediately followed by another number?

Ans « 1. THREE

X 2.FIVE
5 3.FOUR
K 4.8IX

Q.18 Refer to the given letter, number and symbol series and answer the question that

follows. Counting to be done from left to right only.

(Left)y FS@ET7YEVDO3€6%X1Z£€G* (Right)

If all the numbers are dropped from the series, which of the following will be sixth from
the left?

Ans K1Y

o 2. €
X 3.£
KS4T

Q.19 In the following triad, each group of letters is related to the subsequent one following a
certain logic. Select from the given options, the one which follows the same logic.
MAKE - MEKA - AEMK
LOAD - LDAO - ODLA

Ans 5 1. WIND — WDNI — IDWN

& 2. VIEW — WVIE — EWIV
75 3.RENT — RTEN — ENRT
o 4. GROW — ROWG — ORGW

Q.20 \Vijay starts from point A and drives 10 km towards North. He then takes a left turn,
drives 4 km, turns left and drives 12 km. He then takes a left turn and drives 9 km. He
takes a final left turn, drives 2 km and stops at point P. How far (shortest distance) and
towards which direction should he drive in order to reach point A again? (All turns are
90 degrees turns only unless specified)

Ans 25 1.5 km to the east

X 2.4 km to the east
< 3.4 km to the west
" 4.5 Kkm to the west

Q.21 10 is related to 22 following a certain logic. Following the same logic, 24 is related to 50.
To which of the given options is 6 related, following the same logic?

(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 — Operations on 13 such as adding
to/subtracting from/multiplying with 13 can be performed. Breaking down 13 into 1 and
3 and then performing mathematical operations on 1 and 3 is not allowed.)
Ans X 1.18

X 2.16

X 3.14

o 4.12
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Q.22 Eachof M, N, O, P, Q, R and S plays a game on a different day of a week starting from
Monday and ending on Sunday of the same week. M plays the game on Wednesday.
Only two persons play the games between M and Q. O plays the game on the day
immediately before R but not on Thursday. Only two persons play the games between N
and S. N does not play the game on the last day. On which day does P play the game?
Ans «" 1. Monday
X 2. Tuesday
25 3. Thursday
75 4. Friday
Q.23 LF 58 is related to ID 49 in a certain way. In the same way, YK 36 is related to VI 27. To
which of the following is RO 61 related, following the same logic?
Ans X 1.0M 52
w¥ 2.0V 53
&K 3.0G 55
& 4.0H 59
Q.24 Select the triad which follows the same pattern as that followed by the two triads given
below. Both triads follow the same pattern.
HN-JF-MO
MS-OK-RT
Ans < 1. PV-SN-UY
5 2. PU-SN-WY
" 3. PV-RN-UW
X 4. OU-SM-wY
Q.25 19 s related to 64 following a certain logic. Following the same logic, 28 is related to 91.
To which of the following is 44 related, following the same logic?
(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 — Operations on 13 such as adding /
subtracting / multiplying etc. to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)
Ans & 1.193

o 2. 131
X 3.113
X 4.139

Q.26

Ans

Section : Basics of Computers and Application

What is the difference between Reply and Forward in email?

«” 1. Reply sends your response only to the original sender, while Forward sends the email to a new recipient.

5 2. Reply sends the email to all contacts, Forward sends it to none.
/X 3. Reply deletes the original message, while Forward saves it.

/X 4. Reply encrypts the email, Forward does not.

Q.27

Ans

An email containing sensitive information is received from a client. It needs to be
forwarded to a colleague for further action. What measures should be taken to
safeguard the sensitive information during this process?

" 1. Forward the email as is.
75 2. Redact the sensitive information before forwarding.
#5 3. Call your colleague and verbally share the sensitive information.

#5 4. Delete the mail containing sensitive information
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Q.28 In a switched Ethernet LAN, which switching method begins forwarding a frame as

soon as the destination MAC address is read, resulting in the lowest latency but
higher risk of forwarding corrupted frames?

Ans 5 1. Cut-Through Switching
5 2. Token Passing
" 3. Store-and-Forward Switching

#5 4. Fragment-Free Switching

Q.29 Which of the following best describes the role of PCB in a computer system?

Ans 5 1. An input device for transferring data
#5 2. A physical board connecting electronic components
75 3. A protocol used in wireless networks

«" 4. A software tool for virus removal

Q.30 In MS PowerPoint, which feature enables inserting tables from MS Word or MS Excel?
Ans 75 1. File > Import

25 2. Insert > Object
#5 3. Insert > Table
«” 4. Home > Table

Q.31 Consider the following statements regarding inserting and deleting rows and
columns in tables in MS Word 2021:
New rows can be inserted only at the end of a table using the Tab key.
The Layout tab under Table Tools allows users to insert or delete rows and columns
at any position within the table.
The Right-click context menu provides quick options for inserting and deleting
rows or columns.
Which of the above statements is/are correct?

Ans #5 1. Statement Only 2 and Statement 3
/5 2. Statement 1, Statement 2, and Statement 3
#5 3. Statement Only 1 and Statement 3
" 4. Statement Only 1 and Statement 2

Q.32 In R1C1 reference style, how is the cell located at column E and row 8 represented in
Microsoft Excel 20217

Ans " 1. 8R5C
X 2.R8C5
/X 3.8RC5
X 4.RC85

Q.33 Which shortcut allows you to select an entire sentence in MS Word 365 without
dragging the mouse?

Ans #5 1. Ctrl + Click
w” 2. Ctrl + Shift + —
#5 3. Ctrl + Shift + End

5 4. Ctrl + Click anywhere in the sentence

Q.34 Where can you find options to change the design template of your presentation?

Ans «¥ 1. Home tab
X 2. View tab
/< 3. Insert tab
X 4. Design tab
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Q.35 What shortcut key is used in Windows OS to navigate between open programs?
Ans X 1. Alt + Del

X 2.Alt+F4
o 3. Alt + Tab
X 4. Alt+Ins

Q.36 What factors should be considered for optimal document printing results?

Ans X 1. Printer selection, paper type, print quality, color options, and page range settings affect printing outcomes and resource
efficiency.

#5 2. Printing settings have no impact on final results.

w# 3. All documents print identically regardless of settings.

#% 4. Default printing settings are always appropriate.

Q.37 Which toolbar in Excel or Office applications allows you to draw shapes, arrows, and
flowchart elements?

Ans «" 1. Formatting Toolbar
/% 2. Standard Toolbar
/5 3. Formula Toolbar
75 4. Drawing Toolbar

Q.38 How can a user attach a file to an e-mail in most e-mail clients?
Ans 5 1. Go to the Edit menu and select 'Add File'

" 2. Click the 'Send' button and select a file
#5 3. Click the 'Attach File' or paperclip icon and select a file
#% 4. Press Ctrl + A to attach a file

Q.39 Clip art includes:
Ans «" 1. Sound files

25 2. Only charts
#5 3. Animated GIFs & drawings
7% 4. Only videos

Q.40 You have a large, comma-separated data set pasted into Word, where each line
represents a new row and the commas (,) separate the data that should occupy
individual cells. To accurately convert this text into a table while ensuring the data is
parsed correctly, which sequence of actions must you take while using MS Word in
Microsoft 3657

Ans «” 1. Select the entire text, go to the Insert tab, click Table, and select Quick Tables, then choose the appropriate style.

/5 2. Select the entire text, go to the Insert tab, click Table, and select Convert Text to Table, then confirm that the separator
character is set to Commas.

#% 3. Select the entire text, open the Table Properties dialog box, navigate to the Row tab, and specify a fixed row height, which
automatically triggers the conversion.

75 4. Select the entire text, go to the Layout tab (under Table Tools), select Text Direction, and choose the Convert Text to Table
option.

Q.41 Windows comes with a that displays currently opened programs. It also
allows users to access any specific programs.

Ans " 1. task manager
75 2. taskbar
25 3. start menu

#X 4. file explorer
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Q.42 The system software component is responsible for booting up the computer
system.
Ans X 1. CLI/GUI
/< 2. BIOS/UEFI

5 3. HDMI/VGA
«" 4. CGIETF

Q.43 Which of the following statements about Power Saving Mode in MS Word is TRUE?
Ans 5 1. MS Word automatically adjusts performance and reduces background operations when the computer’s power-saving mode
is enabled
«" 2. MS Word has a dedicated “Power Saving Mode” that reduces CPU usage and disables editing features

/X 3. Power Saving Mode in Word automatically converts all documents to plain text to save energy.

/5 4. Enabling Power Saving Mode in Word disables printing and spell-checking permanently

Q.44 In MS Excel, which option allows you to insert a new column between column B and C?
Ans " 1. Right-click on Column C header — Insert

/X 2. Use "Clear Contents" option

5 3. Right-click on Column B header — Delete

75 4. Select Column C — Press Delete

Q.45 Which of the following is a correct combination of commonly used Internet services
and their primary functions?

Ans " 1. FTP — browsing websites; Email — live chatting; VoIP — printing files
5 2. FTP — transferring files; VolP — voice communication; Email — sending and receiving messages
25 3. WWW — file transfer; Email — real-time video calling; Telnet — sending photos

X 4. Email — remote access; WWW — file encryption; FTP — managing hardware drivers

Section : Mathematics
1

ade Simplify: [{sin®0 — cos®6}— ] + 2cos?6
sin* + cos?0
Ans X 1.1
X 2.0
X 3.2
o 41
Q.47

If E and F are two mutually exclusive events such that P(E) = % and P(F) = é , then
find the P(not E and not F).

Ans » 2
i3

x2 2

6

><31

R

><41

3
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Q.48 The coordinates of the centroid of the triangle ABC whose vertices are A(-16, 13), B(-2,
-9) and C(2, 13), is

A
"X (_E E)
3

"3
X2 (_E 1_5)
3" 3
X3 (_E E)
3" 3
( 16 17)
g4 |—— =
3 " 3
Q.49  Simplify (2.5 x 0.48 + 0.6) + (3.5 + 1.6 + 0.8) — (4.8 x 0.25 + 0.8).
Ans X 1.8
X 2.6
K 3.7
& 4.5

Q.50 The HCF of two numbers, each having three digits, is 19 and their LCM is 760. The
number of such pairs is:

Ans w0 1.0
K 2.3
X 3.2
X 4.1

Q.51 9921t
3

A hemuspherical bowl has em’ of water in it. If a ball of radius 2 cm is dropped into the bowl,

the water level is raised up to the height of the bowl without any extra spillage of water out of the bowl.
What is the radius of the bowl?
Ans 5 1.8cm
X 2.6cm
X 3.4cm
' 4.2cm

Q.52  The angles of a triangle are (2x+ 5)°, x© and (3x—17)°. Find the value

of x.

Ans X132
X 2.48
X 3.40
o 4.24

Q53 Triangle ABC is similar to triangle PQR. AM and PS are altitudes and AN
and PT are medians. If% = §= the area of triangle PQR 15 150 cm? and
BC = 6 cm, then the sum of the lengths of AM and QR 1s:
Ans 5 1.38cm
£ 2.28cm
& 3. 24cm
o 4. 36 cm
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Q.54

Ans

A cylindrical pillar is 28 cm in diameter and 25 m in height. Find the cost of painting the

curved surface of the pillar at the rate of ¥50 per m2,

22
(Use T= 7)

& 1.31100
X 2.31138
X 3.%1080
X 4.31072

Q.55

Ans

Given that 112017 = X, 112094 = y and x* = y6 , then the value of z is close to:
K 1.34.19

X 2.34.73
o 3.33.18
X 4.322

Q.56

Ans

The following table represents the marks obtained by six students in an aptitude test.
Study the data carefully and answer the questions given below by matching the
following types.

Student A B C D E F
Marks 48 50 52 55 60 65

Match the following (standard deviation values are rounded off to two decimal places):

A. Standard deviation of entire dataset l.5.88

B. Standard deviation of only the middle four values (B, C, D, E)|ll. 3.77
C. Standard deviation of only first three values (A, B, C) Il. 4.08
D. Standard deviation of only last three values (D, E, F) IV. 1.63

A 1.A-1L,LB-I,C-1V,D-1l

A 2.A-1L,B-IV,C-1lll,D-I
w 3A-1LB-1,C-Ill,D-IV
K 4A-I,B-IV,C-I,D-1l

Q.57

Ans

Find the product of all the possible values of ‘a’ for a?x?+a’2x+3=0
to be a quadratic equation with discriminant 28a.

X 1.0

X 2.14
X 3.-12
o 4.-28

Q.58

Ans

If the sum of the 8th and the 12th terms of an AP is 100, and the 20th term is 95, then
what is the 7th term?

X 1.375
X 2.385
X 3.395
o 4.365

Q.59

Ans

A kite is flying in the sky. A person is holding the kite with 40 m long tightly stretched
string. Find the height of the kite (in meters) if the angle made by the string with the
horizontal is 30 degrees.

X 1.20
o 2.30
X 3.15
X 4.10
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Ans

Q.60 [Ifa=18 and d = 30, then sum of first 6 terms of the A.P. is?
Ans £ 1.555
o 2.558
X 3.559
X 4.561
Q.61 In a test, Chris has to answer two questions. The probability that he will answer the
first question correctly is % If he answers the first question correctly, the
probability that he will answer the second question correctly is Z. If Chris does not
answer the first question correctly, the probability that he will answer the second
question correctly is }e. Find the probability that Chris will answer the second
question INCORRECTLY.
[Note: Assume that each question will be answered— either correctly or
incorrectly.]
Ans 19
w1
3
3
<2 _
5
2
X3 —
3
7
- S S
10
Q.62 Find the coordinates of a point P on the x-axis which is equidistant from the points

A(2,3) and B(-4,5).

« 1.(3,0)
X 2.(=17,0)

7
3

|
4

Q.63

Ans

If X and Y are two sets such that X U Y has 56 elements, X has 45 elements and Y has 33
elements, how many elements does X N Y have ?

X 1.13
& 2.22
X 3.19
X 4.25

Q.64

Ans

If the roots of the equation x> — 5x+6 =0 are c.and p, find the value of & + B

X 1.13
X 2.6
X 3.12
4.5
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Q.65 The number of elements in the Power set P(S) of the set S ={1, 2, 3, 4, 5, 6,7, 8} is:
Ans & 1.250

o 2. 256
X 3.247
X 4.258

Section : Basic Science and Engineering

Q.66 Two transistor biasing circuits have stability factors S: = 101 and S: = 15. Which circuit
offers better thermal stability?

Ans 5 1. Both have equal stability
«# 2. Circuit 1
#5 3. Cannot be compared
5 4. Circuit 2

Q.67 In a PNP transistor, an increase in collector—base reverse bias causes a slight increase
in collector current even when the emitter current is held constant. This occurs
primarily because:

Ans 75 1. Hole mobility increases in the collector region
#5 2. The collector resistance decreases due to depletion region expansion
4" 3. The emitter injection efficiency decreases

#X 4. The effective base width decreases with collector-base voltage

Q.68 If the potential difference across a resistor is doubled while resistance remains
constant, the power consumed becomes

Ans X 1. four times
X 2. double

& 3. half
75 4. one-fourth

Q.69 Two conductors of the same material have lengths L and 2L and equal resistance. The
ratio of their cross-sectional areas (A::A:) is

Ans K 1.1:4
o 2.12
X 3.4
X 4.2:1

Q.70 When several resistors are connected in series, which physical quantity has an
identical value across each resistor?

Ans 5 1. Power
" 2. Voltage
#5 3. Current
5 4. Resistance

Q.71  Which of the following statements correctly describes weight?

Ans 25 1. Weight is measured in kilograms
#5 2. Weight has both magnitude and direction
25 3. Weight only shows how heavy something is
" 4. Weight has no direction
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Q.72

Ans

For a R-L-C series circuit connected to the input signal 4Vp-p,1KHz periodic sinusoidal
ac signal and the voltage drop across the resistor R measured with the help of CRO
displays a sine wave occupying 2 units total height and volts /div knob at 1V ,then the
RMS current for the circuit is approximately if R=10Q.

X 1.1.414A
% 2.0.071A
& 3.071A
X 4.014A

Q.73

Ans

A logic function is given by F = ABC + DE. You are allowed to use only two input AND
gates and NOT gates. How many minimum number of two input AND gates and how
many minimum number of NOT gates are required to implement this function?

«" 1. 2 AND gates and 1 NOT gate
#5 2. 3 AND gates and 2 NOT gates
X 3.3 AND gates and 3 NOT gates
5 4.4 AND gates and 3 NOT gates

Q.74

Ans

A 5 kg object experiences a gravitational force of about 49 N on Earth. This implies the
value of g used is approximately:

5 1.19.6 m/s?
5 2.9.8 m/s?
5 3.49m/s?
o 4.2 m/s?

Q.75

Ans

A circular loop of radius r is placed in a uniform magnetic field ]__3: If the plane of the
loop is perpendicular to the field, the magnetic flux through the loop is

5 1.21r2B
5 2.2mrB

«" 3. Br
5 4.1r2B

Q.76

Ans

If a charge of 3 C is moved across a potential difference of 15V in 3 seconds, what is
the power developed in the process?

X 110w
X 2.30W
X 3.15W
F4.5W

Q.77

Ans

In a parallel connection, if one resistor breaks (open circuit) then

75 1. Other branches keep working
75 2. Battery gets damaged
#% 3. Voltage becomes zero

«” 4. The entire circuit stops working

Q.78

Ans

The resistivity of a semiconductor decreases with the increase in temperature because:

" 1. Band gap increases
#5 2. Lattice vibrations stop
#% 3. More charge carriers are generated

#5 4. Electrons lose energy
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Q.79

Ans

Port 0 of the 8051 microcontroller differs architecturally from the other ports primarily
because:

5 1. It is reserved only for memory expansion
" 2. It does not contain internal pull-up resistors
#5 3. It cannot function as an output port

#5 4. ltis not bit-addressable

Q.80

Ans

Which of the following materials acts as a good insulator in electric circuits?
25 1. Plastic

#5 2. Graphite
" 3. Iron rod
5 4. Mercury

Q.81

Ans

A straight conductor of length 1 m carrying a current of 5 A is placed perpendicular to a
magnetic field of 0.2 T. The force acting on the conductor is

X 1.10N
X 2.0.04N
X 3.50N
o 4.02N

Q.82

Ans

If the time/div knob of the CRO is on 2 ms/div and the positive half cycle of the periodic
triangular signal occupies 2 unit of the X-axis, then the time period of the signal is

X 1.16 ms

X 2.8ms

& 3.2ms

X 4.4ms

Q.83

Ans

Ohm'’s law may NOT hold true when .

" 1. The temperature of the conductor remains constant
#5 2. The material obeys linear V-I relation
#5 3. The temperature of the conductor increases

#5 4. The conductor is metallic

Q.84

Ans

The Sl unit of specific resistance (resistivity) is

25 1. ohm per square metre
" 2.ohm
X 3. ohm-metre

X 4. ohm per metre

Q.85

Ans

Magnetic flux depends on :

25 1. Area, magnitude of B and its orientation
#5 2. Only area

" 3. Only magnetic field

5 4. Only angle

Q.86

Ans

Which of the following correctly defines the electric field at a point?
#5 1. Energy per unit area
#X 2. Energy available per unit charge
#5 3. Force acting per unit charge

" 4. Force acting per unit mass
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Q.87 If the mobility of the holes is reduced to half its original value, keeping other
parameters constant, then the conductivity of a p-type semiconductor is

Ans X 1. Tripled
" 2. Constant
#5 3. Reduced to half
#5 4. Doubled

Q.88 One coulomb of charge is approximately equal to the charge of
Ans 5 1.6%x106 electrons

75 2.6%x1018 electrons
#5 3.6%1012 electrons
w” 4. 6x1010 electrons

Q.89 The force on a current-carrying conductor in a magnetic field is maximum when

Ans " 1. The current is parallel to the magnetic field
#5 2. The current is perpendicular to the magnetic field
75 3. The current is opposite to the magnetic field

X 4. The magnetic field is zero

Q.90 Which of the following quantities remains the same at all locations in the universe?
Ans «" 1. Weight

/% 2. Gravitational force

5 3. Mass

X 4. Apparent weight

Q.91 An ideal half-wave rectifier supplies a purely resistive load from a sinusoidal source.
Let v (t) be the load voltage and vp(t) be the diode voltage, measured with reference to
the anode. Which of the following statements is always true over one complete cycle?

Ans X 1. The average value of vD(t) becomes zero if the diode orientation is reversed.
«” 2. The average values of vL(t) and vD(t) are equal in magnitude and opposite in sign.
X 3. The rms value of vD(t) equals the rms value of the source voltage.

/X 4. The average value of vD(t) is zero because the diode conducts for half the cycle.

Q.92 Which device converts mechanical energy into electrical energy through
electromagnetic induction?

Ans /5 1. Battery
" 2. Electric motor
#5 3. Electric generator
#5 4. Capacitor

Q.93 If a charge of 2 C placed in an electric field experiences a force of 10 N, what is the
magnitude of the electric field at that point?

Ans

N
X113 —

Z 0

2.2 —

X 3.5

X 4.4

alZalza
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Q.94 In 8051 microcontroller, PSEN is an
accessing the memory.

output signal used as a read strobe for

Ans 5 1. active high, internal ram
25 2. active low, external program
X 3. active low, internal ram

«” 4. active high, external program

Q.95 Which symbol is used to represent a resistor in a circuit diagram?

Ans #5 1. Circle with pointer
25 2. Arrow mark
" 3. Zig-zag line
X 4. Two parallel plates

Q.96 Two resistors 6 Q and 3 Q are connected in parallel. The total resistance is:

Ans W 1.2Q

X240
X 3.90

X410

Q.97 When the two inputs of a 2-input NAND gate are tied together to form a single input A,
the resulting circuit behaves as which logic gate?

Ans X 1.NOT gate (Inverter)
X 2. OR gate
" 3. AND gate
75 4. XOR gate

Q.98 Aresistor of 10 Q is connected to a constant voltage source. When another resistor is
connected in series with it, the current in the circuit becomes half of its initial value.
Assuming the supply voltage remains unchanged, the resistance of the second resistor
is .

Ans X 1.15Q
X 2.100Q
3.50
X 4.20Q

Q.99 If a uniform magnetic field is parallel to the plane of a surface, the magnetic flux
through the surface is

Ans X 1. infinite
X 2. zero
«# 3. maximum

X 4. half of maximum

Q.100 Which of the following is a fundamental (base) quantity in the Sl system?
Ans & 1. Work

X 2. Pressure
X 3. Force
" 4. Mass




